Manual for Program Version 2.0+
23 July 2010
Contents

1 Introduction 1

2 AviStack2 Installation 3
   2.1 Stand-alone AviStack2 versions 3
   2.2 IDL VM 3
      2.2.1 Installation 3
   2.3 Supported video codecs 4

3 Starting AviStack 5
   3.1 The main GUI 5
      3.1.1 The file menu 5
      3.1.2 The settings menu 7
      3.1.3 The processing list 8
   3.2 The processing tree 9
   3.3 The main display 12

4 Working with AviStack2 14
   4.1 Loading imagery 14
   4.2 Frame selection 17
      4.2.1 Quality analysis and automatic frame selection 18
      4.2.2 Manual frame selection 20
      4.2.3 Export data 22
      4.2.4 Creating a movie 22
   4.3 Frame alignment 24
      4.3.1 Alignment type 25
      4.3.2 Area radius 26
<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.3.3</td>
<td>Search radius</td>
<td>26</td>
</tr>
<tr>
<td>4.3.4</td>
<td>Use flat/dark for processing</td>
<td>27</td>
</tr>
<tr>
<td>4.4</td>
<td>The frame alignment diagram</td>
<td>29</td>
</tr>
<tr>
<td>4.5</td>
<td>The frame aligned movie</td>
<td>31</td>
</tr>
<tr>
<td>4.6</td>
<td>ROI selection</td>
<td>32</td>
</tr>
<tr>
<td>4.7</td>
<td>Set reference points</td>
<td>34</td>
</tr>
<tr>
<td>4.7.1</td>
<td>Minimum distance</td>
<td>35</td>
</tr>
<tr>
<td>4.7.2</td>
<td>Structure threshold</td>
<td>36</td>
</tr>
<tr>
<td>4.7.3</td>
<td>Lower cut-off value</td>
<td>37</td>
</tr>
<tr>
<td>4.7.4</td>
<td>Upper cut-off value</td>
<td>37</td>
</tr>
<tr>
<td>4.7.5</td>
<td>Manual manipulation of reference points</td>
<td>37</td>
</tr>
<tr>
<td>4.8</td>
<td>The quality analysis</td>
<td>38</td>
</tr>
<tr>
<td>4.8.1</td>
<td>Quality analysis method</td>
<td>39</td>
</tr>
<tr>
<td>4.8.2</td>
<td>Noise reduction parameter</td>
<td>40</td>
</tr>
<tr>
<td>4.8.3</td>
<td>Quality area size</td>
<td>40</td>
</tr>
<tr>
<td>4.8.4</td>
<td>Manual manipulation of the quality areas</td>
<td>40</td>
</tr>
<tr>
<td>4.9</td>
<td>The quality diagram</td>
<td>42</td>
</tr>
<tr>
<td>4.10</td>
<td>The quality sorted movie</td>
<td>43</td>
</tr>
<tr>
<td>4.11</td>
<td>Reference point alignment</td>
<td>45</td>
</tr>
<tr>
<td>4.11.1</td>
<td>The area radius</td>
<td>46</td>
</tr>
<tr>
<td>4.11.2</td>
<td>The search radius</td>
<td>46</td>
</tr>
<tr>
<td>4.11.3</td>
<td>The quality/frame cut-off</td>
<td>48</td>
</tr>
<tr>
<td>4.12</td>
<td>Reference point alignment diagram</td>
<td>49</td>
</tr>
<tr>
<td>4.13</td>
<td>Frame stacking</td>
<td>51</td>
</tr>
<tr>
<td>4.14</td>
<td>Save stacked image</td>
<td>54</td>
</tr>
<tr>
<td>4.14.1</td>
<td>Image orientation</td>
<td>55</td>
</tr>
<tr>
<td>4.14.2</td>
<td>The minimum and maximum area and the ROI</td>
<td>55</td>
</tr>
<tr>
<td>4.14.3</td>
<td>File types</td>
<td>55</td>
</tr>
</tbody>
</table>
12 Help functionality in AviStack2 85

13 AviStack2’s statistics package 87
  13.1 The statistics objects .......................... 88
  13.2 Defining polygons for an ROI ................. 88

14 Creating your own AviStack2 plug-ins 93
1 Introduction

AviStack is a free-ware tool for astronomy that registers, stacks and processes movies and image sequences.

AviStack uses hundreds or even thousands of reference points to effectively compensate for seeing-related distortions.

This is essential to detect even the smallest details in high resolution Lunar, Solar, and planetary images.

Despite the large number of reference points, AviStack is fast and now, in version 2.0, enables full automatic processing. Simply load a movie and select your favorite settings, choose All automatic as the processing option from the menu Settings and start processing. AviStack2 will then go through all the processing steps without your intervention. This will produce very good results in most standard imagery cases.

However, you always have the option to manually process your imagery. Additionally, you can tell AviStack2 which of the steps you want it to perform in auto mode. This gives you much flexibility and saves a lot of time. In case you recorded a mosaic of the Moon, it will likely be enough to process one movie manually and then use the selected settings and have AviStack2 process all the remaining movies automatically.

AviStack2 now also includes an enhanced post-processing module which will get extended in future versions of AviStack2.

If you have used AviStack 1.x before, the new version will look different to you. However, it incorporates the same sequence of processing steps as did the old AviStack 1.x. So you will quickly adapt to the new look. You will also find AviStack2 much more flexible than the old version (e.g., now, after changing reference points or the threshold values, you will no longer have to repeat the quality analysis).

There are many new features in AviStack2 such as:

- Fully automatic processing.
- Pre-setting of all parameters possible.
- Much faster alignment methods.
- Option to disable display updates during processing (saves much time).
• Automatic frame pre-selection by frame quality and/or brightness.
• Use of flat-fields/dark frames throughout processing to reduce impact of imaging artifacts.
• Creation of false color images.
• Enhanced post-processing module.
• AviStack2 remembers GUI geometry from session to session.
• User contributed XML language libraries.
• A statistics package allows to analyse properties of your movies.
• Write your own plug-ins for AviStack2 (in IDL).

AviStack2 has been tested extensively. However, it cannot be excluded that there are still some programming bugs in there. The code is now so complex that it is impossible to test for every possible combination of parameters used by the users. If you encounter an error, please make a screen shot of the error message and send a brief error report to:

michael@avistack.de

You can also join the AviStack User Group:

http://tech.groups.yahoo.com/group/AviStack/

We hope you enjoy the new AviStack2!

Michael Theusner and Joe Zawodny
2 AviStack2 Installation

You can download AviStack2 from the following internet address:

http://www.avistack.de

There, you will find different (stand-alone) program versions:

- 64-bit-Windows (stand-alone).
- Other operating systems: Run AviStack2 by using a pre-compiled IDL-save-file that requires the IDL VM (see below). The IDL VM is available for practically all operating systems so that you can run AviStack2 on most systems. If you have previously installed the stand-alone-version and there is an AviStack2 update available, you can simply download the new avistack2.sav file and replace it in your AviStack2 program directory.

To enable AviStack2 to load a wide range of AVI codecs, you simply have to download an additional DLL- and DLM-file. For Quicktime movies (e.g. Canon DSLR HD videos) and MPEGs you will also need to install the AviSynth frame server. All this is only possible for Windows users! More about this in Section 2.3.

2.1 Stand-alone AviStack2 versions

Simply download and unzip it to the desired location on your computer. Then start the AviStack2 executable, done!

2.2 IDL VM

2.2.1 Installation

If the stand-alone versions do not work on your system, you can try to manually install the IDL Virtual Machine. This program package (about 270 MB) is provided by ITTVIS and can be downloaded free of charge after registration:
After successful registration you can finally select for your system and
download the software package and install it. Execute the setup file and
follow the instructions. Usually, administrator rights are necessary to install
IDL.

After IDL VM installation, copy the avistack2.sav into a folder of your
choice. However, under no circumstances change the name of the file or
its suffix. Otherwise, it will not execute. Apart from this, no other steps are
necessary.

2.3 Supported video codecs

AviStack2 supports AVIs recorded with the Y800-codec (uncompressed
grey scale), DIB-codec (uncompressed color) and I420/IYUV-codec (we-
bcams), i.e. all grey scale and color movies recorded with the cameras
of The Imaging Source (http://www.astronomycameras.com/de/
products/) as well as films taken with the Philips ToUCams. Additionally,
it is possible to process series of images of the following formats: PNG,
JPG, BMP, TIFF, JP2, FITS (also 16 bit). That way basically every type of
AVI can be used if it is split up into single frames beforehand.

AviStack2 also loads SER movies recorded with the Lucam-Recorder.

For Windows users, only: To load a wide range of AVI codecs
with AviStack2 you can download two additional DLL and DLM
files. These were compiled by Ronn Kling and are freely availa-
ble from his homepage. Click on krsgravi on the website http:
//www.kilvarock.com/dlms.htm to download the file krsgravi.zip.
Unzip it and copy the files KRSgrAVI.dll and KRSgrAVI.dlm to the
AviStack2 program directory - done! AviStack2 is then able to use all
the AVI codecs installed on your computer.

If you also want to load Quicktime videos and MPEGs, then install the
AviSynth frame server, which will read almost all MOVs and MPEGs.
Just try it out.

If your codec is still not supported by AviStack2, simply use VirtualDub
(http://virtualdub.sourceforge.net/) to convert your AVI to DIB
(...save as AVI).
3 Starting AviStack

In this section, the three basic windows of AviStack2 are explained. These are the main GUI (Section 3.1), the processing tree (Section 3.2) and the main display (Section 3.3).

You can freely rearrange all the windows and resize some of them and AviStack2 will remember their geometry from session to session. This does not apply to most of the file picker dialogs, the location of which is managed by the operating system.

After a successful installation of AviStack2 you can run the program simply by starting the appropriate executable. When you start the program for the first time, you are kindly asked to confirm the End User License Agreement (EULA). This is also required after a program update. Then confirm the following IDL VM window and the main program window will appear (Fig. 1). If you want to switch to a language other than English go to → Settings → Language select a language and restart AviStack2.

3.1 The main GUI

AviStack2’s main GUI contains the File, Settings and About menus (see sections 3.1.1 and 3.1.2), a text window for displaying hints (see section 12) and the processing list with its buttons (see section 3.1.3).

3.1.1 The File menu

The File menu contains the following entries:

- **Load movie**: Loads movie files.
- **Load images**: Loads an image series by selecting the images.
- **Load folder**: Loads an image series from a folder.
- **Load images (post-processing)**: Loads images for post-processing, only.
- **Save data**: Saves an AviStack2 data file (.asd).
Figure 1: The GUI of AviStack2. Upper left: The main GUI including processing list. Lower left: The processing tree (Parameters and settings). Right: The main display.
3.1 THE MAIN GUI

- **Load data**: Loads an AviStack data file (AS1 and AS2).

- **Restore session**: Restores the last AviStack2 session from an .asd file which is automatically saved when you quit AS2.

- **Save parameters**: Saves the current processing parameters to an AviStack2 parameter file (.asp).

- **Load parameters**: Loads processing parameters from an AviStack2 parameter file (.asp).

- **Default parameters**: Resets the processing parameters to their default settings.

- **Generate flat-field**: Generates a flat-field from the currently selected file in the processing list.

- **Generate dark frame**: Generates a dark frame from the currently selected file in the processing list.

- **Exit**: Quits AviStack2. Automatically saves the session to AviStack2.asd in AviStack2’s program directory (the file can be restored via → **Restore session**).

3.1.2 The **Settings** menu

The **Settings** menu contains the following entries:

- **Language**: Lets you select one of the available languages. You will have to restart AS2 to implement your selection. See section 11.

- **Processing**: Lets you quickly set all processing steps to either manual or auto mode. See section 5.1.

- **Update display**: Lets you quickly toggle between having AS2 update All or None of the displays during processing. See section 3.3.

- **Color table**: Allows you to modify, create, save and load color tables which are used with the color mode **User defined**. See section 3.3.
3.1.3 The processing list

There is one big difference between AviStack1 and AviStack2 when it comes to loading files. In AS1, processing started immediately after loading a file. In AS2, the selected file(s) will be listed in the processing list (see Fig. 1). Only after hitting Process file or Batch processing does actual processing start. This gives you the opportunity to first collect all the files you want to work on. At the same time, this list can be used to collect all files for batch processing. Above the processing list, you can find the button bar (see Fig. 2). It allows you to e.g. add files to the list and delete items.

- Figure 2a: Add one or several movies to the list.
- Figure 2b: Add an image series by selecting images.
- Figure 2c: Add an image series by selecting a folder containing the images.
- Figure 2d: Add an AviStack data file (.asd).
- Figure 2e: Add one or several images for post-processing.
- Figure 2f: Delete all selected items.
- Figure 2g: New session. Clears the processing tree.
- Figure 2h: If activated, automatically saves an AviStack data file when frame stacking is finished.
- Figure 2k: Help button.

A right mouse click on the processing list opens a context menu (Fig. 3) which contains the following entries:
3.2 THE PROCESSING TREE

- **Delete item(s):** Deletes all selected items from the processing list.

- **Reprocess item(s):** Toggles state of processed items to unprocessed.

- **Duplicate item(s):** Duplicates all selected items.

- **Add parameter file (.asp) to item(s):** Attaches an AviStack parameter file to the selected items. These parameters are implemented before the file is processed.

- **Delete parameter file (.asp) from item(s):** Removes any attached parameter files from the selected items.

- **Add workflow file (.wrkf) to item(s):** Attaches an AviStack workflow file (post-processing parameters) to the selected items. These parameters are implemented before the file is post-processed.

- **Delete workflow file (.wrkf) from item(s):** Removes any attached workflow files from the selected items.

- **Generate flat-field:** Creates a flat-field from the selected item and saves it.

- **Generate dark frame:** Creates a dark frame from the selected item and saves it.

- **Preview:** Opens a window containing a thumbnail view of the movie or image series. Does not work for some .asd files.

### 3.2 The processing tree

The processing tree (Fig. 4) lists all the processing steps that you probably already know from AviStack1.x. The color of the respective folder icons tells you whether or not a step is already accessible (green = yes; red = no). A double click on one of the green=accessible folders loads the respective module. If a folder is colored red, you can still modify its parameters by double clicking a wrench icon. The module is then open in preset mode.
In the following, a brief overview is given as to what each of the modules is good for. There seem to be more steps than there were in AviStack1. This is actually not the case. They are just presented in a more organized manner. Many of these steps can be automated (see Section 5.1) and you will actually not have to go through all of them yourself.

- Properties: Lists all the basic properties of the movie or image (series) that you process. A double click on the folder icon opens the movie selection dialog.

- Frame selection: This module is automatically started when you start processing a file. It allows you to deactivate frames that you want to exclude from processing. It also enables you to perform a quality and brightness analysis of the movie/image series. You can then use that information to automatically exclude frames with respect of selected thresholds.

- Frame alignment: Lets you choose the alignment points for the frame alignment.

- Frame alignment diagram: Displays the result of the frame alignment. Allows to eliminate misaligned frames.
Figure 4: The processing tree.
• Frame aligned movie: Lets you view the frame aligned movie. Windows users who have KRSgrAVI installed can write the frame aligned movie to a user selected file.

• ROI selection: Selection of a region of interest. Limits further processing to that area.

• Set reference points: Threshold selection and placement of reference points.

• Quality analysis: Selection of quality analysis parameters and placement of the quality areas.

• Quality diagram: Displays the average frame quality (by frame and sorted by quality).

• Quality sorted movie: Lets you view the movie with the frames sorted by average frame quality or for a selected quality area. Windows users who have KRSgrAVI installed can write the quality sorted movie to a user selected file.

• Reference point alignment: Selection of the parameters for reference point alignment. Starts the alignment process.

• Reference point alignment diagram: Displays the result of the reference point alignment.

• Frame stacking: Allows to choose a flat-field and/or dark frame for frame stacking. Initiates the stacking process.

• Save stacked image: Set the parameters for saving the stacked image (32-bit-Fits recommended!). You can also choose which part of the image you want to save.

• Post-processing: Lets you post-process the image using the available tools.

• Save processed image: Set the parameters for saving the post-processed image.

3.3 The main display

In the main display, AviStack2 will display all the relevant data during processing.
However, displaying an image or other data takes quite a lot of time. In AviStack1.x, this caused some of the main processing steps (frame alignment, quality analysis, reference point alignment and frame stacking) to last much longer than it took to compute the actual data. Therefore, there is now the option for these steps to disable the display. This can be done for each of the modules separately while they are running. Additionally, you can also do this for all at once via → Settings → Update display.

A further display option is to choose the display mode, either 100 % or scaled to the current window size. You can resize the main display to a size of your choice. AviStack2 will then remember these maximum dimensions and scale the window according to the selected display mode and the current frame size. If you resize the window to a size larger than the current frame dimensions, it will adapt itself to the size of the frame. The maximum allowed dimensions are remembered, however, in case larger frames are displayed later.

You can also choose from six different color modes. These are Original, User defined and four pre-defined false color modes. The user defined mode is especially interesting if you want to create your own color table for converting into RGB your gray scale Solar imagery.

See Section 6 for details on how to create color tables.

The button Screen shot allows to save the current content of the display to a PNG file of your choice.
4 Working with AviStack2

In this section a detailed step-by-step guide through all processing steps is given. Later, the automatic mode is explained (Section 5.1) as well as batch processing (Section 5.2).

The different processing steps are all visible as the tree in the processing tree window (Section 3.2, Figure 4). At first, all the folders are of red color (except the first). This means that processing has not yet progressed to that stage. As you process your movie, more and more of these folders will change their color to green, indicating your progress.

Green folders’ dialog windows are fully accessible by double click. Red ones can only be opened in preset mode by double clicking on one of the folder’s wrench icons. Each wrench icon indicates that the associated parameter can be changed in preset mode even though processing has not progressed to that stage. This way you can change all parameters before you have started processing.

At any time, you can halt the processing and go back to any processing step by double clicking on a respective green folder icon. If you have opened an earlier processing step and confirm it with OK, you will have to continue processing from there. All results from later steps are then lost and the subsequent folder’s colors are reset to red! Use Cancel instead, if you want to continue processing from where you left it. There is one exception: If you have already performed the quality analysis and then change the reference points, you will not have to repeat the quality analysis! This is different from what you probably know from AS1.x.

A single click on one of the + signs in the processing tree will expand or hide the associated tree structure.

4.1 Loading imagery

After you have started AS2, the processing list is empty (Section 3.1.3, Figure 1). You can now fill it with imagery you want to process. These can be loaded via the buttons above the processing list (Section 3.1.3, Figure 2) or via the File menu.

You have the choice between loading

- movie(s) (Fig. 2a),
4.1 LOADING IMAGERY

- image series (Fig. 2b),
- image series by specifying the folders they are contained in (Fig. 2c),
- AviStack data files (.asd) (Fig. 2d) and
- images for post-processing (Fig. 2e).

In the first three cases, processing starts right from beginning. In the case of .asd files, processing will resume at that step where you saved the file. If you open images in post-processing mode, only the last two processing steps will be available (actual post-processing and saving the file).
In this example three AVIs are loaded via the load-movie-button above the processing list (Fig. 5a). Correspondingly, three items appear in the processing list. These can be rearranged by drag-and-drop (Fig. 5b). If you want to delete some of the items, just mark them and hit the red X button (Fig. 5c). Or you right click on the processing list and select Delete item(s) from the context menu. Now that there are some items in the processing list, actual processing can begin. Select one item (click on it, Fig. 6a) and then hit Process file (Fig. 6b). If you mark several items and then start processing, only the first of the selected files will get processed.

Immediately after you have hit the Process file button, the frame detection will start. This may take a few seconds and after the movie has been analyzed, the Frame selection dialog is opened. In the processing list, a start time entry is added to the currently processed item (Fig. 6c).

If you load images for post-processing, AviStack2 directly proceeds to the post-processing dialog. All other processing steps then remain unavailable.
4.2 Frame selection

**Task(s)**
Deactivate frames that suffer from low quality or other deficiencies.

**Purpose**
Provides for reduced processing times. Prevents AviStack2 from accidentally including frame defects.

After you have started processing the frame selection dialog is opened (Figure 7). It consists of the Help and Collapse/Expand window buttons, the quality analysis and the frame tree.

Clicking the Help button opens a help dialog with a detailed explanation of the current processing options. This basically is a summary of what you can find in this manual. So, if you do not know what to do, just click on the ubiquitous help buttons. The Collapse/Expand window button allows...
to collapse or expand the current window. That way you can have a look at the underlying windows and the information contained therein without moving the frame selection window. Both these buttons are available for most dialogs.

All the quality and frame selection settings are optional. If you want to keep all the frames, just click on OK and processing will continue with the next step: Frame alignment (see Section 4.3).

However, it is often beneficial to perform a basic quality analysis of the movie’s frames (Section 4.2.1). This then enables you to filter out the worst frames and speed up later processing steps. This mainly has an effect on frame alignment and the quality area analysis. The reduced number of frames does not have a large effect on the most time consuming step, the reference point alignment. Another benefit is that AS2 is then able to automatically select the best frame as master for the frame alignment (this can always be done manually, too, see Section 4.3).

You can also perform a manual frame selection (Section 4.2.2).

If you are not happy with your current selection, you can restore the initial one by hitting the Reset button (red arrow).

In case you are processing DSLR images, due to the size of the frames, AviStack2 may run out of memory to complete processing. You will then encounter an error message like Unable to allocate memory: to make array. To remedy this, you can select to process only one of the three channels of the RGB color images (see R, G and B buttons, Figure 7). However, you will have to process the three channels separately, one after the other.

When you are complete with your selection, hit OK and the frame alignment parameter dialog is opened (Section 4.3).

4.2.1 Quality analysis and automatic frame selection

The quality analysis options become available as soon as you check the box Quality analysis (see Figure 8a).

The options are as follows:

- Quality cut-off: The percentage number of frames you want to keep.
- Use frame cut-off: If checked, will keep a user defined fixed number of frames.
4.2 FRAME SELECTION

(a) Enable quality analysis.

(b) Set fixed frame cut-off.

(c) Start quality analysis.

Figure 8: The frame selection dialog: Quality analysis.

- Brightness cut-off: Will filter out all frames with a brightness of less than x% of the brightest frame (averaged over the entire frame). This setting ignores the number of frames set by the quality analysis cut-offs. If the number of frames filtered out by the brightness cut-off is smaller than the one imposed by the quality cut-off, additional frames are deleted.

In this example the movie has 200 frames and a fixed frame cut-off of 150 frames is selected (Figure 8b). The quality cut-off is automatically set to 75% which is the percentage of 150 out of 200 frames. The brightness cut-off is left at 0% which allows all frames regardless of their brightness.

To start the quality analysis, just hit the button Calculate (Figure 8c). Immediately after that, a small progress window is opened (Figure 9) which displays the currently processed frame number, the elapsed time, the estimated remaining time and the estimated full time. When the analysis is complete, the selected threshold values are enforced and the worst 25%
frames are deactivated. This can be seen from the frame list. All deactivated frames are now marked with a red X in the list and crossed out in the display (Figure 10).

The previous Calculate button has now changed to Apply (Figure 10). So, if you alter the cut-off settings, you will not have to perform a quality analysis again. You can then simply hit the Apply button to adopt the new values.

Just to the right of the slider for the brightness cut-off, a button with a diagram icon is located. If you click on it, another dialog is opened where you can view the frame brightness diagram. Holding the left mouse button and dragging the mouse allows you to draw a cut-off line (Figure 11). The value of this cut-off is then used for the brightness cut-off. All frames with a brightness below the drawn line are deactivated after hitting OK. If you don't want to adopt your selection, just hit Cancel.

### 4.2.2 Manual frame selection

Instead of or additionally to the automatic approach (see Section 4.2.1), it is possible to deactivate frames manually. This can be done by selecting a frame by using the slider or by selecting it from the frame list. Then use the red X to deactivate the frame or the green check mark to activate it (see e.g. Figure 10). If you first click on one of the frames in the frame list, you can then go through the rest of the list using the arrow keys using the space bar to toggle between active and inactive state of a single frame.

In case you want to deactivate a large number of frames at once, you can simply select the first one. Then hold the shift key and mark a second frame. All other frames in between these two are then selected and you can change their state by using the X or check box. If you want to select additional frames, hold the control key and then click on a specific frame in the frame list. It is then added to the current selection.
4.2 FRAME SELECTION

Figure 10: The frame selection dialog after a completed quality analysis.

Figure 11: Manual selection of the brightness cut-off.
4.2.3 Export data

It is possible to export quality and brightness analysis data and other frame selection data to external files. Go to the Data menu at the top of the frame selection dialog (Figure 7) and select Export. Then another dialog is opened which allows you to export various data sets (Figure 12):

- List of active frames: Lists the indexes of the active frames.
- List of frame activity flags: A list of ones and zeros indicating whether a frame is active or not.
- Average frame quality and brightness.

See Section 7 for details.

4.2.4 Creating a movie

If you have KRSgrAVI installed as a Windows user (Section 2.3), you are able to create a movie from the active frames. Simply click on the Write movie button (Figure 7) and select a file name. Then another window pops up and lets you choose from a list of codecs available on your system. After the necessary adjustments, writing of the movie starts. This process can be interrupted by hitting Cancel.
This way you can easily convert an image series into a movie. This is certainly not limited to astronomical imagery.

If your slider is set to the first or last frame, the full movie will be written. If it is set on any of the other frames, the movie will be written up to that frame.

AviStack2 does not allow you to overwrite movies already present on your hard drive. This prevents you from accidentally destroying some of your files.

Just as a reminder: KRSgrAVI is external code not maintained by the developers of AviStack2.
4.3 Frame alignment

| Task(s) | Select a good frame as master for the frame alignment. Place two alignment points. The frame where the alignment points are placed automatically becomes the master frame. |
| Purpose | Detection of the frame drift and analysis of the seeing conditions. Allows for simplified reference point alignment and the automatic selection of a search radius for the reference point alignment (Section 4.11). |

After the frame selection is complete and confirmed with OK, the frame alignment dialog is opened (Figure 13).

It consists of

- standard help and expand/collapse window buttons,
- three arrow buttons which allow to reset and undo/redo up to 20 of your actions,
- a button (two boxes with + signs) that will initiate the automatic placement of the two alignment points,
- a button (green box with mouse cursor) which will mark the currently displayed frame as master for the frame alignment,
- one button to jump to the current master frame,
- the sliders and buttons for the frame alignment parameters (detailed below) and
- a secondary display which shows a 2x magnified view of the area in the main display around the current cursor location.

If you have previously performed a basic quality analysis, AS2 will propose as master what it thinks is the best frame. You can always change this by selecting a different frame by using the slider and the respective button (see above). However, you will rarely have to use this button as the frame where you place the two alignment points, automatically becomes the master.

You can place the alignment points manually:
4.3 FRAME ALIGNMENT

- The first alignment point is placed with the left mouse button.
- The second alignment point is placed with the right mouse button.

If you want AS2 to select suitable locations for the alignment points, just hit the respective button (see above).

Suitable locations for alignment points are distinct surface features which are easy to track. You should also take care that the two alignment points are not too close together. This is because if the seeing distortions at both locations are correlated, a faulty seeing evaluation may result and have a negative impact on the evaluation of the search radius for the reference point alignment (Section 4.11). The Lunar limb and sometimes also the Solar limb usually aren’t good locations for alignment points. The points may start to drift along the limb during frame alignment and the process would then fail.

A detailed description of the frame alignment parameters follows in Sections 4.3.1 to 4.3.4.

After selecting appropriate settings, hit OK. Immediately, the alignment of the frames starts and a progress window pops up. You then have the option to uncheck Update display to speed up the process. The window also includes information on the elapsed and estimated total duration of the alignment (see Section 4.2.1, Fig. 9).

At any time can you interrupt frame alignment by hitting Cancel.

After frame alignment is complete, the frame alignment diagram is displayed (Section 4.4).

4.3.1 Alignment type

You can choose between two different alignment types:

- Surface (for Lunar and Solar imagery)
- Planet (for the planets)

These affect the way the alignment points are recovered as described in Section 4.3.3.
4.3.2 Area radius

The area radius determines the size of the area around the two alignment points that is used to detect their location in other frames. If you choose it too small, AS2 may have trouble to recover them. If the radius is too large, many different seeing effects are averaged and this may negatively impact the seeing quality analysis. The default of 24 pixels is a good value for most occasions. However, if your frames are quite featureless, you may have to increase it to achieve successful alignment.

4.3.3 Search radius

The search radius defines the maximum distance from the last known location of an alignment point where AS2 will try to recover it in the next analyzed frame.

For alignment type Surface a search radius of $x$ pixels means that AS2 is able to recover an alignment point in the $n^{th}$ frame from the master at a distance of $n \cdot x$ pixels!
4.3 FRAME ALIGNMENT

Figure 14: Automatic placement of alignment points using the respective button.

In the case of alignment type *Planet*, the center of brightness of the object will be used additionally to recover the alignment points. You can then reduce the search radius.

If a selected search radius is too small, AS2 may lose track of the features chosen as reference. If the radius is large, you run the risk that AS2 locks on the wrong location. If the use of large search radii is required, you should also increase the area radius.

If alignment was successful can be seen from the frame alignment diagram (Section 4.4).

4.3.4 Use flat/dark for processing

You can tell AViStack2 to use a flat-field and/or dark frame during processing and not only for the final frame stacking. Check the box if you have such data available and want to use them.

The flat-field and dark frame can be selected by expanding the folder *Frame stacking* in the processing list (Section 3.1.3) and double click-
ing on one of its two wrench icons. This will then open the appropriate dialog window in preset mode.

Do this before you select the alignment points by closing the frame alignment window using Cancel! Do not use OK as this would prematurely initiate the frame alignment process.

The advantage of using a flat-field and/or dark frame during processing is that defects like dust specks do not have a negative impact on the recovery of alignment points and the reference point alignment. However, processing times will slightly increase.

The creation of flat-fields and dark frames is explained in Section 8.
4.4 The frame alignment diagram

<table>
<thead>
<tr>
<th>Task(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>If necessary, eliminate misaligned frames.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ensures that only properly aligned frames are used to create an unbiased master for placing reference points and for reference point alignment.</td>
</tr>
</tbody>
</table>

After the frame alignment is complete, the frame alignment diagram is displayed. It consists of three graphs (Figure 15):

- The relative deviation between the two alignment points in pixels (top).
- A histogram of the aforementioned relative deviations (center).
- The frame shifts in pixels (bottom).

The top graph lets you easily recognize if frame alignment was successful (Figure 15) or whether there are misaligned frames. The latter stand out as outliers (Figure 16). AviStack2 will automatically propose which frames to exclude from further processing. This is done by cutting off all frames with a deviation three times as large as or larger than the deviation data’s median value. You can always change this proposed value (visible as the red line in Figure 16) by holding the left mouse button pressed in the top graph and dragging it. The number of still active and deactivated frames is shown by the respective labels in the dialog window (Figure 15).

Alternatively, you can repeat the frame alignment with different values for the search radius, area radius and/or alignment point locations (Section 4.3).

**This graph is not necessarily an indicator of frame quality (it actually often isn’t). So do not use it to eliminate what you think are low quality frames. Instead, use the quality analysis available for the frame selection (Sections 4.2 and 4.2.1).**

The second graph displays the data of the top graph as a histogram.

The bottom graph shows the frame shift. That is the shift of a frame with respect of your master frame (in both x- and y-directions).

In the majority of cases, it will not be necessary to eliminate frames. If this is the case or you have chosen to exclude some, hit **OK**. Subsequently, the frame aligned movie is displayed (Section 4.5).
Figure 15: The diagram in case of successful frame alignment.

Figure 16: The diagram in case of failed alignment for one of the frames.
4.5 The frame aligned movie

<table>
<thead>
<tr>
<th>Task(s)</th>
<th>None.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Lets you view the alignment of the frames. Allows to write a frame aligned movie (Windows users, only. KRSgrAVI required).</td>
</tr>
</tbody>
</table>

This module lets you view the alignment of the frames. Use the slider to move through the frame aligned movie. You will notice that the frame drift has been eliminated. The remaining differences between the frames are now almost exclusively due to atmospheric distortion.

If you have KRSgrAVI installed as a Windows user (Section 2.3), you are able to create a movie from the aligned frames. Simply click on the Write movie button (Figure 17) and select a file name. Then another window pops up and lets you choose from a list of codecs available on your system. After the necessary adjustments, writing of the movie starts. This process can be interrupted by hitting Cancel.

If your slider is set to the first or last frame, the full movie will be written. If it is set on any of the other frames, the movie will be written up to that frame.

AviStack2 does not allow you to overwrite movies already present on your hard drive. This prevents you from accidentally destroying some of your files.

Just as a reminder: KRSgrAVI is external code not maintained by the developers of AviStack2.
4.6 ROI selection

<table>
<thead>
<tr>
<th>Task(s)</th>
<th>Select a region of interest (optional).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Allows to limit further processing to a subsection of the frames. Beneficial if you quickly want to try out different processing parameters and also reduces processing times.</td>
</tr>
</tbody>
</table>

For planetary imagery that has a lot of black space around your object, you can limit further processing to the interesting part of the frame. Just click into the display, hold the left mouse button and drag the mouse cursor. A box is drawn which surrounds your ROI = region of interest (Figure 19).

It is probably also worthwhile to use a ROI if you quickly want to try out different settings for the reference point alignment. This is because selecting a small ROI will speed up processing.

If you want to reset or undo/redo your actions, use the arrow buttons. Up to 20 of your actions are remembered by AviStack2.

In case you want to use the whole area, press the button with the dashed box and four outward pointing arrows. This is the default setting when the dialog window is opened (Figure 18).

After your (optional) ROI selection is complete, hit OK. Then, AviStack2 proceeds to the reference point selection (Section 4.7).
4.6 ROI SELECTION

Figure 18: The ROI selection dialog with its initial selection.

Figure 19: Selecting a ROI by drawing a box around the desired area.
4.7 Set reference points

<table>
<thead>
<tr>
<th>Task(s)</th>
<th>Set reference points and choose suitable threshold values.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>The reference points are later used to eliminate the atmospheric distortions from the frames. The threshold values allow AviStack2 to distinguish between areas covered by the recorded object and those covered by space or otherwise featureless areas. Such featureless areas are unsuitable for an alignment of reference points.</td>
</tr>
</tbody>
</table>

The reference point dialog allows you to manually (Section 4.7.5) and automatically place reference points. These are then used to eliminate the atmospheric distortions from the frames to ultimately generate an undistorted image. You must place at least one reference point to be able to continue.

To allow AviStack2 to place reference points automatically, four different parameters are available:

- The minimum distance (Section 4.7.1),
- the structure threshold (Section 4.7.2),
- the lower cut-off value (Section 4.7.3) and
- the upper cut-off value (Section 4.7.4).

With respect of AviStack1.x, the threshold selection and reference point placement have now been combined into one module. The parameters for the reference point alignment are now located in a separate module.

When the dialog is opened, AviStack2 automatically places reference points using the selected parameters (see Sections 4.7.1 to 4.7.4). You can vary those parameters and AviStack2 will immediately use the new values to compute new reference point locations. After the automatic placement, you can manually alter the reference points (Section 4.7.5).

The image that is displayed in the main display, is shown initially using false color mode number four. You can change this at any time. Also, it is shown including the effect of the structure threshold and cut-off values. All areas which are thus excluded from automatic reference point placement are shown as black (Figure 20). However,
4.7 SET REFERENCE POINTS

Figure 20: Reference point placement dialog.

you can always manually place reference points in those areas. If you want to hide the effect of the threshold and cut-off values, right click into the main display (Figure 21; and right click again to show it).

The template that is used to place the reference points and which is shown in the main display, is the mean of all aligned frames.

If you are unhappy with one of your actions, you can undo/redo them using the arrow buttons (up to 20 actions).

When you are finished with placing reference points, click on OK. AviStack2 then continues with the selection of quality analysis parameters (Section 4.8).

4.7.1 Minimum distance

There now is only one parameter (instead of two in AviStack1.x) that determines the density of automatically placed reference points, the minimum distance. It can be varied between 5 and 50 pixels. However, the use of minimum distances below about 12 pixels is strongly discouraged. It only increases processing time and rarely with any benefit when it comes
Figure 21: Deleting reference points by drawing a box around them.

to image sharpness. Usually, you should not go below 18. The resulting number of reference points is already enough to produce optimal results.

4.7.2 Structure threshold

The structure threshold is an arbitrary value that tells AviStack2 what amount of structure is required that a certain area can be considered suitably for reference point placement. Low values will allow for the use of smooth areas, while higher values permit highly structured areas, only. This way you have a simple measure to distinguish between an object and areas of the frame which are covered by space. You no longer have to manually choose the two lower and upper cut-off values.

A structure threshold of 70 is the default and works very well on most occasions. However, there are some cases where you will have to use the lower cut-off value, additionally. That is when you have very noisy data and only few frames.

Do not worry if many areas get excluded. There are usually still enough left for reference point placement.
If you use a structure threshold of zero, some areas will still get excluded.

### 4.7.3 Lower cut-off value

The lower cut-off value lets you exclude areas below a certain brightness from automatic reference point placement. It can be varied between 0 and 1. Where a value of one corresponds to the maximum possible pixel brightness (e.g. 255 for 8-bit-data and 65335 for 16-bit-data). This way you won’t have to change this parameter even if you use imagery with different bit depth. Usually, you won’t have to use this parameter (leave it at 0.0).

Only when your data are very noisy and you have only a small number of frames, even the highest structure threshold may not be high enough to prevent placement of reference points in areas of space. Then, set the lower cut-off to a suitable value greater than zero.

### 4.7.4 Upper cut-off value

This parameter is equivalent to the lower cut-off value and excludes from automatic reference point placement areas with brightness above the selected value. This way you can eliminate overexposed areas. However, these are usually already filtered out by the structure threshold.

### 4.7.5 Manual manipulation of reference points

At any time can you add or delete reference points manually.

A double click on a location in the main display without a reference point creates a new one.

A double click on a reference point deletes it.

You can delete a large number of reference points by drawing a box around them. Click on a location, hold the left mouse button and drag the mouse. A box is drawn and all reference points within its boundary are deleted when you release the mouse button (Figure 21).

You can delete all reference points at once by using the X- button. Use X+ to initiate automatic placement of reference points which you can then alter manually, again.
4.8 The quality analysis

| Task(s) | Select the parameters for the quality analysis. Define quality areas. |
| Purpose | The quality analysis allows to distinguish between sharp and blurry areas of the frames. For each quality area the quality is computed in each frame. Later, only the reference points in areas above a user defined quality threshold are aligned and stacked. |

As soon as the quality analysis dialog is opened, AviStack2 computes locations for centers of quality areas (red +, Figure 22). The initial quality areas are, therefore, generated automatically. However, you can alter them manually (Section 4.8.4).

In contrast to AviStack1.x, the quality areas in AviStack2 are not a fixed grid. This has some major advantages as these areas can adapt themselves to curved structures like the Lunar and Solar limbs. This way, quality areas that contain only small parts of an object can be avoided as quality analysis data are usually not quite as reliable for these areas.

Additionally to the quality areas, the location of the reference points is
4.8 THE QUALITY ANALYSIS

Figure 23: A progress dialog is shown while the quality analysis is running.

shown as well.

There are three parameters that affect the quality analysis:

- The quality analysis method (Section 4.8.1),
- the noise reduction parameter (Section 4.8.2) and
- the quality area size (Section 4.8.3).

After you have set the quality areas, hit OK. Then, the quality analysis is performed and the associated progress window is shown (Figure 23). When the analysis is finished, the quality analysis diagram is displayed (Section 4.9).

4.8.1 Quality analysis method

The default is the standard quality analysis that is already known from AviStack1.x. It simply analyses the quality of the frame data contained in a certain quality area in each frame.
Now, there is a second method which will perform an alignment of the quality area before the quality analysis is performed. That way, it is ensured that the quality of the same data is compared in each quality area.

However, this process can be slow and it is beneficial on only a few occasions. The only known so far is for Solar prominence imagery with an overexposed disk and recorded with long focal lengths.

You can certainly try out if the additional time spent aligning the quality areas is justified by an improvement in quality of the stacked image.

For the large majority of users, the standard quality analysis is recommended.

### 4.8.2 Noise reduction parameter

The noise reduction parameter is used not only for the quality analysis, but, also for the reference point alignment. It enables AviStack2 to more easily distinguish between noise and a frame’s actual structures. So for reference point alignment, this allows to use smaller area radii.

The noise reduction’s default is 1. It should be adjusted such that noise is largely reduced without smoothing the frame too much. Its effect can be seen in the main display. You probably only have to change this parameter if your data are very noisy.

### 4.8.3 Quality area size

This parameter determines the minimum distance between the quality areas’ centers and, thus, their size. You can select from values between 32 and 256 pixels and the default is 84.

Do not choose them too small as the fractional content of a quality area that changes from frame to frame due to atmospheric distortions increases for small areas. Their quality analysis data are consequently a little less reliable. The use of values above 48 pixels is recommended.

### 4.8.4 Manual manipulation of the quality areas

Just like with the reference points (Section 4.7.5), you can delete and add quality areas.
A double click on a location in the main display without a quality area center (+) creates a new one.

A double click on a quality area’s center deletes it.

You can delete a large number of quality areas by drawing a box around their centers. Click on a location, hold the left mouse button and drag the mouse. A box is drawn and all quality areas the centers of which are within the box’s boundary are deleted when you release the mouse button (cf. Figure 21).

You can delete all quality areas at once by using the button with the red X. Use the button with the quality area grid to initiate automatic placement of quality areas which you can then alter manually, again.
4.9 The quality diagram

<table>
<thead>
<tr>
<th>Task(s)</th>
<th>None.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Review of the average frame quality.</td>
</tr>
</tbody>
</table>

The quality diagram (Figure 24) shows the average quality for each frame. It allows you to check the variation of the seeing conditions during the recording of the movie. Also, it displays a diagram with sorted quality values. It may also help you with the selection of an appropriate quality cut-off.

Using → Data → Export, you can write to file the data used in the diagram. See Section 7 for details.

Upon closing the window via OK, the quality sorted movie dialog is opened.
4.10 THE QUALITY SORTED MOVIE

Task(s)
Check the result of the quality analysis.

Purpose
A method to check the reliability of the quality analysis. Permits creation of a quality sorted movie (Windows users, only. KRSgrAVI required).

This module lets you view the movie sorted for the average frame quality or a certain quality area. Use the slider to move through the quality sorted movie from the best frame to the last. This allows you to check how reliable the sorting is for each quality area. To select a certain quality area simply left click in the main display (Figure 25). If you want the movie displayed sorted by average frame quality, do a right click in the display.

The dialog window will always tell you what quality area you selected and what the active and original frame indexes are for the currently viewed
frame. This way you can always identify a certain frame also in your original movie.

It also shows the quality cut-off that corresponds to the current sorting index. So you can easily see what the frame quality looks like for a certain quality cut-off. The quality cut-off is then set by you in the reference point alignment dialog (Section 4.11).

Using → Data → Export, you can write to file the data for a certain quality area. See Section 7 for details.

If you have KRSgrAVI installed as a Windows user (Section 2.3), you are able to create a movie from the quality sorted frames. Simply click on the Write movie button (Figure 25) and select a file name. Then another window pops up and lets you choose from a list of codecs available on your system. After the necessary adjustments, writing of the movie starts. This process can be interrupted by hitting Cancel.

If your slider is set to the first or last frame, the full movie will be written. If it is set on any of the other frames, the movie will be written up to that frame.

AviStack2 does not allow you to overwrite movies already present on your hard drive. This prevents you from accidentally destroying some of your files.

Just as a reminder: KRSgrAVI is external code not maintained by the developers of AviStack2.
4.11 Reference point alignment

**Task(s)**
Select appropriate reference point alignment parameters as well as the quality/frame cut-off. The latter determine how many frames are stacked for each reference point.

**Purpose**
Preparation of the parameters that are used for the reference point alignment.

This dialog (Figure 26) lets you choose the parameters for reference point alignment. These parameters are:

- The area radius (Section 4.11.1),
- the search radius (Section 4.11.2) and
- the quality/frame cut-off (Section 4.11.3).
In the main display, the reference point alignment master is shown together with the reference points. You will notice that no points are shown up to a certain distance from the master’s edge. These are reference points too close to the edge so that AviStack2 is unable to align them. This is due to the fact that AviStack2 would have to use image data from outside the area covered by the master and/or a frame which is impossible. Therefore, reference points which are closer to the edge than the sum of area radius and search radius are excluded. The box (Figure 26) indicates the area where reference point alignment is possible. Its size changes when you change either the area radius or search radius.

After you have selected appropriate parameters, hit OK. The reference point alignment is then performed and the associated progress window is shown (Figure 27). AviStack2 will align the reference points for each frame in those quality areas, where the quality is above the selected threshold. The reference points’ master locations are shown as the white plus signs while their location detected in the current frame is shown in red (Figure 27). Again, you can speed up processing by turning off Update display.

When alignment is complete, the reference point alignment diagram is displayed (Section 4.12).

### 4.11.1 The area radius

The area radius determines the size of the area around a reference point that is used to detect its location in other frames. If you choose it too small, AviStack2 may have trouble aligning them. If the radius is too large, many different seeing effects are averaged and this may negatively impact the alignment and, consequently, the quality of the stacked image. The default of 24 pixels is a good value for most occasions. However, if your frames are quite featureless, you may have to increase it to achieve successful alignment.

You will notice that reference points

### 4.11.2 The search radius

The search radius defines the maximum distance from the reference point location in the master where AviStack2 will try to align that reference point in a frame.
The default is that the search radius is automatically computed from the deviation data of the frame alignment (see Section 4.3). However, you can set it manually after unchecking the *Automatic search radius* box.

If a selected search radius is too small, AviStack2 may not be able to detect the correct reference point location. This is despite the fact that AviStack2 is able to find reference points beyond the selected limit to a certain degree.

If the radius is large, you run the risk that AS2 locks on the wrong location. If the use of large search radii is required, you should also increase the area radius.

Whether or not alignment was successful can be seen from the frame alignment diagram (Section 4.12).
4.11.3 The quality/frame cut-off.

This value is one of the most important as it determines the stack size for the final image.

You can either choose a percentage value so that the ultimate stack size will vary with the length of your movies.

However, in AviStack2, you now have the option to let AviStack2 stack a fixed number of frames. Check the respective box and insert the number of frames you want to stack (Figure 28). In this example the selected stack size is 100 out of 150 frames. The quality cut-off is automatically adjusted to this new value (now 66.6 %). As long as the box Use frame cut-off is checked, AviStack2 will always use the fixed number of frames.
4.12 Reference point alignment diagram

**Task(s)**
Check the result of the reference point alignment.

**Purpose**
Provides information on the deviations encountered during reference point alignment.

The reference point alignment diagram displays a histogram of the deviation values encountered during reference point alignment. It provides information on how far away from their location in the master reference points were detected in the movie frames and how often. Like the histogram shown here (Figure 29), there usually is a large maximum at small deviation values with a more or less long tail towards larger deviations.

If reference point alignment fails, you will encounter deviations much larger than the chosen limit for the search radius. Or, there are increasing numbers of deviations towards the end of the tail. In such cases, it is recom-
mended to increase the area radius for the reference point alignment to ensure successful alignment.

Note that it is not a big problem if there are some outliers as those have only a negligible effect on the quality of the stacked image.

You have the choice between standard and logarithmic display of the histogram. In this case, standard display was selected while logarithmic is the default.

It is possible to export the data of the histogram to a file (→ Data → Export). See Section 7 for details.
4.13 Frame stacking

Task(s)
Select a flat-field and/or dark frame for frame stacking (optional).

Purpose
The flat-field and dark frame can be used to remove imaging defects from the movie frames. Starts the stacking process.

The frame stacking dialog allows the optional selection of a flat-field and/or a dark frame (Figure 30). These will then be used during the stacking process and enable to eliminate imaging defects.

You can use a flat and/or dark for the frame alignment and reference point alignment, too. If you want to do so, you will have to select a flat and/or dark right after frame selection by opening this window in preset mode (click on one of the wrench icons in the folder Frame stacking; Figure 30). After that, return to the frame alignment window (double click on the respective folder) and continue processing from there.

Figure 30: The frame stacking dialog lets you select a flat-field and/or dark frame for the stacking process.
Before you are able to select a flat-field and/or dark frame, you will have to have created them as described in Section 8.

To select a flat/dark, just click one of the two yellow folder buttons. A file selection dialog is opened and allows you to pick a file. If the dimensions of the selected file do not agree with the ones of the movie, a warning is issued and file selection is canceled.

As soon as you have selected a valid file, its data are displayed in the main display. You can always toggle between the flat-field and dark frame display by clicking on the image buttons.

Once you have selected a file, it is added to the respective pull down menu and you can easily select it next time you want to use it. AviStack2 checks if files stored in the list are still in their expected location when you start the program another time.

When you are done with the flat-field/dark frame selection, hit OK and the stacking process is started (Figure 31).
After a successful stacking process, the dialog for saving the stacked image is opened (Section 4.14).
4.14 Save stacked image

**Task(s)**
Choose parameters for saving the stacked image.

**Purpose**
Save the result of the stacking process.

When finally saving the stacked image, you can set a number of parameters:

- The image orientation (Section 4.14.1),
- the section of the image to be saved (Section 4.14.2),
- the file type and pixel depth (Section 4.14.3),
- the file name and the saving location (Section 4.14.4) and
- output of a parameter file (.asp) (Section 4.14.5).
When you have completed selecting appropriate parameters, hit Save and the image is saved. Then you can decide to alter the settings and save the image e.g. in a different format (hit Save, again). To continue with post-processing (Section 4.15), hit Close.

### 4.14.1 Image orientation

You can apply rotations of 0, 90, 180 and 270° to your image and flip it horizontally and vertically. Just select the appropriate entries from the two pull-down-menus.

### 4.14.2 The minimum and maximum area and the ROI

It is possible to save different sections of the stacked image.

The minimum area is the largest area that is common to all the frames, independent of drift of field of view. For each pixel, the selected (maximum) amount of frames is stacked (lowest noise) and reference point alignment is performed (elimination of atmospheric distortions). Therefore, it is the area of the highest quality. This section is selected as default.

The maximum area is the full area which is covered due to drift of the field of view. Therefore, there may be pixels where less frames than the selected number get stacked or even non at all. No reference point alignment is performed in those parts of the maximum area which are located outside the minimum area. Thus, noise is stronger in those parts and the image will likely be less sharp. However, it can be beneficial to save the maximum area if you use telescopes without tracking.

The ROI is only then different from the minimum area if you have selected one during processing (Section 4.6). It is then smaller than the minimum area.

### 4.14.3 File types

You can save the stacked image as FITS, TIFF, PNG and JPEG. For FITS, you can save the file with 8, 16 and 32 bits. TIFF and PNG can both be saved with 8 and 16 bits and JPEG with 8 bits, only.

It is highly recommended to save the stacked image as 32-bit-FITS. Only then is the full pixel depth available if you want to post-process the image
at another time (within AviStack2 or another program). You can always save the data in a different format, additionally.

FITS also has the advantage that all the processing parameters are stored in its header. So if you save the maximum area and post-process the FITS some other time, you will be able to extract the minimum area from it and avoid post-processing artefacts at the image’s edges. This would not be possible with any of the other formats.

4.14.4 File name and saving location

As a default, the name of the stacked image is constructed from the movie name plus the appropriate image type extension. However, you can change the file name and specify a suffix which will be added to the saved file.

The default location to save the file is in the same directory as that of the processed movie. However, should you process movies from CD/DVD, you can specify a different directory.

If you check the box Use as default on the Save dialog, AviStack2 will use the selected directory again for all subsequent movies that you process.

4.14.5 Parameter file output

If you check the box Save parameters (as in Figure 32), an AviStack2 parameter file is created and saved under the same name as the saved image file. Only its extension is changed to .asp.

Saving a parameter file with the image data has the advantage that you will later always be able to process other movies with the same settings as the current one. So you’ll always be able to reproduce your processing at a later time.

AviStack2 parameter files are small, so it is recommended to always save such a file with your stacked image.

See Section 10 for more information on AviStack2 parameter files and how to use them.
4.15 Post-processing

<table>
<thead>
<tr>
<th>Task(s)</th>
<th>Choose tools and their parameters to post-process the stacked image.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Enhance image detail.</td>
</tr>
</tbody>
</table>

After you have saved the stacked image, you can post-process it to enhance image detail e.g. by sharpening it. To do this, AviStack2 currently provides two tools:

- A wavelet sharpening tool (Section 4.15.1) and
- a levels tool (Section 4.15.2).

There are another two tools which are for information purposes, only:

- A histogram tool (Section 4.15.3) and
WORKING WITH AVISTACK2

4.15.1 Wavelet sharpening

Wavelets apply a series of high and low pass filter pairs to the image in order to isolate features according to their spatial scale. Each filter is called a wavelet layer. The row of buttons across the top of the wavelet tool is

- a show clipping tool (Section 4.15.4).

The number of tools will increase with future versions of AviStack2.

You activate a tool by clicking on its tree entry. Click again to deactivate it.

You can rearrange the order of the tools by drag-and-drop. This affects the order the tools are applied to the image data (top to bottom).

The order of the tools and their settings constitute a workflow. You can save a workflow file via → Workflow → Save. You can then restore the same tool parameters at another time via → Workflow → Load. This is useful for creating workflows for specific types of imaging (e.g., Lunar, Solar, Hα, or planetary).

Refer to Section 6 to find out how to display and save a false color image.

When you are finished post-processing your image, hit OK. Directly after that, the dialog window for saving the post-processed image is opened. There you can select an image format and also alter the orientation of the image. This dialog has the same functionality as the one for saving the stacked image. Refer to Section 4.14 for a detailed description. It is recommended to either use 16-bit-TIFF or 16-bit-PNG (default) to save your post-processed image. You can then process them further with other image processing software and later convert them to 8 bits for Internet use.
used to select the maximum number of wavelet layers to be used (Figure 34).

Each wavelet layer has two parameters that determine its properties, the spatial scale of the wavelet and its amplitude. The settings for each layer can be set by adjusting two sliders. The top slider for each layer determines the spatial scale. It sets the width of a Gaussian where the slider value is the sigma of the Gaussian in pixels.

The amount of detail captured by a layer can be enhanced or suppressed by adjusting the amplitude slider (the lower slider for each layer). Positive values enhance or sharpen the image, negative values soften the image, and a value of -1 removes that detail completely.

The value of each setting is presented at the end of each slider. The values can be reset to their default values (sigma = 0.20*layer and amplitude = 0) by simply clicking on the value you wish to reset. The values can also be adjusted by dragging a slider bar, clicking on the slider on either side of the bar (produces large steps), clicking the arrows at either end of the slider (smallest steps), or by clicking on the slider and then using the arrow keys on your keyboard (smaller steps).

The wavelets are applied layer by layer from 1 to the maximum number or last non-zero amplitude layer. The sigmas should increase from layer to layer. It is not unusual for each subsequent layer to have a sigma that is twice that of the previous layer. Changes to any settings are applied immediately and the display of the new image is nearly instantaneous for all but the largest images.

### 4.15.2 Levels

The levels tool is a simple way to adjust the contrast (dynamic range) of your image and to adjust its gamma (Figure 35). This can be done for the whole image or for individual colors with RGB color images. Which layer is affected is determined by selecting the color channel via the channel pull down menu.

The top portion of the tool is used to display the channel intensity histogram. The histogram likely spans a large range and a Log graph setting is provided so the user can see all of the data. Just below the histogram are parameters for the input levels, three triangles and their corresponding numerical values. The two end triangles can be dragged to limit range
of image data (input) to be used. Dragging the left (black) triangle towards the center will darken the blacks. Similarly, dragging the right triangle (white) will brighten the whites. The center gray triangle adjusts the image gamma.

At the bottom of the tool are similar triangles and numerical values for the output scale. Any of these values may be set directly by editing the numerical values followed by the return key.

Adjusting the input levels is useful for expanding the image to fill the full range of available intensities. Adjustments to the output levels can be used to correct for over exposure conditions introduced by excessive sharpening. This is why most users will likely place the levels tool after the wavelet (or other future) sharpening tool being used.

### 4.15.3 Histogram

The histogram tool will display the distribution of intensity levels in your image at the point in the workflow where the tool is located (Figure 36). This tool only provides information to the user and does not alter the image in any way. In addition to the Log graph setting found in the levels tool, the histogram tool also has a Limit setting which, when set, displays the histogram for the image data as it would written to a non-FITS file (all values between 0 and $2^{\text{bit-depth}}$).
4.15 POST-PROCESSING

4.15.4 Show clipping

With the Show clipping tool off image data less than zero are displayed as black and image data greater than the maximum value allowed by the bit depth (256, 65535, …) are displayed as white. When active, the color table is applied so that slightly negative values become white and values enhanced beyond the maximum value for the bit-depth become black. For RGB images this is done for each color component, so the result may be unusual coloring. Quickly toggling this tool will allow the user to identify problem areas in the image. Since all of the post processing uses floating point calculations, these problem areas can often be minimized by changing the output levels in the levels tool. The clipping tool does not alter the image data and never creates any artifacts in the saved image data.
5 Automation in AviStack2

5.1 Automatic processing (single file)

The new AviStack2 now enables fully automatic processing of your movies! This is especially useful for the novice who wants quick results without digging too deep into the way AviStack2 works (Section 5.1.1).

For the more experienced user who wants the best results possible, there are still many steps that can be automated (Section 5.1.2). This functionality is especially useful for those who record several movies with similar content (e.g. Lunar mosaics). In such cases it often is sufficient to process the first movie in manual/partially automatic mode. Then switch all processing steps to auto and then start Process file or Batch processing (see Section 5.2).

The more experience you get, the more will you realize that you will have to process only few of your movies in semi-automatic mode and the rest fully automatic over night (see batch processing, Section 5.2).

The new AviStack2 will likely save you a huge amount of time during processing. So you can concentrate on post-processing the stacked images.

There is a simple way to toggle a processing step from manual to automatic: For each processing step, there is an entry in the tree initially labelled Manual processing or Stop processing (Figure 37). Manual processing indicates that you have the option to manually change settings before processing continues. Stop processing means that processing is interrupted so that you can view e.g a diagram. No further manipulation of parameters is necessary in this case.

You can toggle from manual to automatic setting with a single left mouse click. The respective tree item will then change to Automatic processing and Continue processing, respectively (Figure 38). Automatic processing indicates that AviStack2 will perform all the necessary actions that you would usually do manually. It will then use the current parameter settings of that processing step. Continue processing will cause AviStack2 to skip a processing step like a diagram.

You can toggle the state of the auto/manual settings all at once via Settings → Processing → All automatic or → All manual. If you want everything automatic except post-processing, then choose Settings → Processing → All automatic (except post-processing).
5.1 AUTOMATIC PROCESSING (SINGLE FILE)

Figure 37: The Manual processing and Stop processing settings in the processing tree.

Figure 38: The Automatic processing and Continue processing settings in the processing tree.
Now follows a list of the impacts Automatic processing has on the different processing steps.

- **Frame selection (Section 4.2):** If Quality analysis is enabled, will perform the quality/brightness analysis. Then, frames will automatically be deactivated according to the selected thresholds.

- **Frame alignment (Section 4.3):** Automatically places the alignment points, determines the *Alignment type, surface or planet.*

- **Frame alignment diagram (Section 4.4):** Automatically eliminates misaligned frames.

- **ROI selection (Section 4.6):** No action taken, full frame used.

- **Set reference points (Section 4.7):** Automatically places the reference points using the current parameter settings.

- **Quality analysis (Section 4.8):** Automatically places the quality areas using the current parameter settings. Then performs the quality analysis.

- **Reference point alignment (Section 4.11):** Computes the search radius (if set to automatic) and performs the reference point alignment according to the selected parameters.

- **Frame stacking (Section 4.13):** Stacks the frames using the optional flat-field and dark frame files.

- **Save stacked image (Section 4.14):** Saves the image according to the settings. If a file of the same name is already present, a date/time extension is added to prevent overwriting.

- **Post-processing (Section 4.15):** Applies the active post-processing tools to the stacked image.

- **Save processed image (Section 4.15):** Saves the image according to the settings. If a file of the same name is already present, a date/time extension is added to prevent overwriting.

Steps not listed here are simply skipped (*Continue processing*).
5.1 AUTOMATIC PROCESSING (SINGLE FILE)

5.1.1 For the novice

As a novice you will likely want quick results and not fiddle around with all the settings available in AviStack2. Before you do anything about automating AviStack2, think about what file format you prefer for the stacked image. 32-bit-FITS certainly is best, however, usually not readable by standard image processing software. Therefore, expand the folder Save stacked image in the processing tree (hit the +). Then double click on one of the wrench icons and the corresponding window pops up. There you can choose a different file format like 16-bit-TIFF or PNG (see Section 4.14.4). Then hit OK.

It is then best to select → Settings → Processing → All automatic (except post-processing). The program will then process your movie fully automatically and stop at the post-processing step. You can then post-process the stacked image by playing around with the available tools (Section 4.15). Or, you can simply skip this step and process the next movie. Or you quit AviStack2 and process the stacked image (located in the same folder as the movie you just processed) with standard image processing software.

In most cases, the fully automatic approach works well. However, there are cases where it could fail. Especially when there is a large amount of drift in the movie or the data are relatively featureless (e.g. some white light Solar imagery). Long focal lengths can also be problematic (drift and effect of atmospheric distortion is stronger).

5.1.2 What to automate?

Even for an experienced Lunar, Solar and planetary imager, most of the processing steps can be automated.

Once you have found suitable settings for the frame selection (Section 4.2), you will likely rarely do this manually.

Frame alignment probably is something you would want to leave on manual (Section 4.3). Then you can quickly check if AviStack2 placed the alignment points appropriately.

It is recommended to check the frame alignment diagram (Section 4.4) to be sure it worked properly. AviStack2 will automatically determine which frames are likely misaligned, anyway. You can then either repeat the frame alignment or eliminate the misaligned frames by just hitting OK in most cases.
Skip the frame aligned movie (Section 4.5) by setting it to *Continue processing*.

Skip the ROI selection (Section 4.6) by setting it to *Automatic processing*.

Check the reference points (Section 4.7) manually.

The quality analysis (Section 4.8) can be set to *Automatic processing* on most occasions. Skip the quality diagram (Section 4.9) and quality aligned movie (Section 4.10), set both on automatic.

Automate the reference point alignment (Section 4.11) unless you frequently change the number of frames you want to stack.

Check the reference point alignment diagram (Section 4.12) manually. If there is something amiss, repeat the reference point alignment.

Leave the frame stacking (Section 4.13) on manual to choose the proper flat-field and dark frame.

Saving the stacked image (Section 4.14) can likely be automated.

Post-processing (Section 4.15) should be left on manual unless you want to apply the same workflow to several of your movies.

Set the saving of the post-processed image to automatic.
5.2 BATCH PROCESSING

5.2 Batch processing

Batch processing is almost the same as automatic processing (Section 5.1). With automatic processing, you can only process one file at a time. Batch processing, however, will automatically process all the objects listed in the processing list (Section 3.1.3) one after the other (Figure 39).

5.2.1 Standard batch processing

So if you want to process the movies of a Lunar mosaic, you can simply process the first file manually or semi-automatically, so you can verify you have selected the proper settings, and then all the rest by simply hitting Batch processing. AviStack will then apply the current settings of the processing steps to all the other files, too (with exception of the parameters
that are computed automatically), and process them automatically.

**AviStack2 ignores the manual settings in batch processing mode. Everything is on automatic by default. There is one exception: If you leave post-processing on manual, batch processing will continue with the next file in the list after saving the stacked image. It will then not perform post-processing. You can do manual post-processing later by loading the stacked images.** This is useful primarily because the amount of wavelet sharpening you will wish to apply is very sensitive to the amount and type of detail in the image. It is likely that any test case you may run while setting the parameters initially will not represent the most challenging image in the batch.

In Figure 40 a running batch processing is displayed. The first file is already completed and the second is just being processed. If you expand the completed entry in the processing list, you will find that it lists the times processing started and ended and the duration.

Hitting one of the *Cancel* buttons during batch processing will stop it. You can then continue manually with the currently processed file or hit *Batch processing* again. In the latter case, AviStack2 will resume batch processing from where you stopped it. However, the file where you stopped batch processing will get processed anew.

### 5.2.2 Using different parameter settings

As mentioned in Section 5.2.1, AviStack2 will use the currently implemented parameter settings to process all the files in the processing list.

So what to do if you want to process files with different settings during batch processing?

There are two different options:

- **Save AviStack2 data files (.asd; Section 9) and load those into the processing list.** AviStack2 will then implement the settings contained in each .asd file before it processes the respective movie file.

- **Save AviStack2 parameter files (.asp; Section 10) and attach these files to the items in the processing list.** AviStack2 will then implement the settings of the attached .asp file before it processes a file. The same can be done with workflow files which contain the parameters for post-processing.
Figure 40: Batch processing is running.
In the latter case, proceed like this (it is assumed that you have already saved different .asp files):

1. Mark the items in the processing list that you want to process using certain settings (Figure 41).

2. Right click on the selection and choose Add parameter file (.asp) to item(s) (Figure 41).

3. Load your .asp file.

If you then expand the selected items, you will find that each of the selected items now has the .asp file attached (wrench icon, Figure 42)

You can then select the remaining three items and attach a different .asp file to them. If you don’t, AviStack2 will use the parameters of the last implemented .asp file for those as well.
5.2 BATCH PROCESSING

Equivalent, you can attach workflow files (.wrkf) to the items to implement different post-processing parameters.

You can delete these attached files by using the respective entries in the context menu (right click on processing list).
Figure 43: Defining a custom color table.

6 User defined color tables

Color tables can be created via $\rightarrow$ Settings $\rightarrow$ Color table. Select $\rightarrow$ Define if you want to create a color table from scratch or $\rightarrow$ Modify if you want to modify the custom color table currently in use. It is also possible to load and save color tables as can be seen from the respective menu entries. See Section 6.1 for details.

You can display your movie frames using the custom color table by using color mode User defined from the pull down menu just above the main display.

While you are modifying a color table, all changes are immediately visible in the main display. So you can easily select the best color table settings to color your gray scale images.

See Section 6.2 to find out how to save an image with custom color table applied (false color image).

6.1 Creating a color table

As stated above, use $\rightarrow$ Settings $\rightarrow$ Color table $\rightarrow$ Define or $\rightarrow$ Modify to create a new color table (Figure 43). On hitting one of the two entries, the color table modification tool is loaded (Figure 44).

The tool consists of three main elements (Figure 44):
6.1 CREATING A COLOR TABLE

Figure 44: The color table definition tool.

- The color gradient displaying the currently defined color table.
- A bar where you can add/delete/modify colors and their gamma values.
- A button bar.

Each little colored box under the color gradient defines a color stop. Between each of the stops a color gradient is interpolated to fill in the colors in between the stops. The gamma value for the gradient is designated by the triangle symbols. The initial setting of the gamma values is 1.0.

To change the color of one of the color stops, double click it. Then, a color picker tool pops up and you can select a color (Figure 45). Hit OK and the color stops color will have changed.

You can also simply add new color stops by double clicking a location without one (see Figure 47). Then, again, the color picker tool pops up and lets you select a color for that new stop. You can alter the location of all the color stops by dragging them around. Only the first and the last stop are fixed.

The gamma values can also be modified by dragging the triangle symbols.

If you want to delete one of the color stops, just right click on it. A right click on a gamma symbol resets it to 1.0.

If you are finished with your color table, hit OK. If you do not want to implement the currently created color table, use Cancel.

You can load and save color tables via → Settings → Color table → Load and → Save and also the respective button in the button bar of the color table definition tool.
Figure 45: The color picker tool.

Figure 46: Color of the last color stop changed from white to light yellow. The color gradient updates itself to each new setting. Double clicking on a location without a color stop adds a new one (see Figure 47; current mouse cursor location indicated by the large dotted +).

Figure 47: A new color was added (dark red). The location of the new color stop can be changed by dragging it (see Figure 48).
6.2 Saving a false color image

If you choose a color mode other than Original from the main display’s pull down menu, AviStack2 will display the current content of the display using the color table associated with the selected false color mode. This does not apply to diagrams, however. These are always displayed with fixed colors.

If you now want to save the post-processed image as a false color image (e.g. H-α images, see Figure 49), do the following:

1. Use color mode User defined throughout post-processing and finish the latter by confirming your settings with OK (Section 4.15). Then, the dialog for saving the post-processed image is opened.

2. Select User defined as color mode. The image is subsequently displayed using the custom color table.

3. Hit Save.

The saved image will always look like the one displayed on the screen.

It is not recommended to save the stacked image using custom colors! These data should always be stored using color mode Original as they form the basis for every post-processing.
Figure 49: Creating a color table for H-α images.
7 Export data

As already mentioned in Section 4, you can export to external files various data sets created during processing. This means that you can now make with a program of your choice your own plots using AviStack2 data.

You have the choice between the following data formats (Figure 50a):

- **CSV**: Comma separated values. A plain text data format that saves the data using one of the available delimiters (semicolon, comma, space, tab; see Figure 50b). Readable by e.g. Microsoft Excel.

- **NetCDF**: Network Common Data Format. Scientific, self-describing data format.

- **HDF5**: Hierarchical Data Format. Scientific, self-describing data format.

If you select NetCDF as output format, you will need special programs to read the data. There is a large number of such programs, many of them are freely available. For a list of such programs refer to: [http://www.unidata.ucar.edu/software/netcdf/software.html](http://www.unidata.ucar.edu/software/netcdf/software.html).

For manipulating and displaying HDF5 data see e.g. [http://www.hdfgroup.org/hdf-java-html/hdfview/](http://www.hdfgroup.org/hdf-java-html/hdfview/).

The CSV data format is plain text and therefore readable by text editors and can easily be imported into e.g. Microsoft Excel.

The content of such a CSV file looks like this:

```
5
3
640
Average frame quality and brightness
```

<table>
<thead>
<tr>
<th>Original frame index</th>
<th>Average frame quality (normalized)</th>
<th>Average frame brightness</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.82955; 131.93965</td>
<td>131.93965</td>
</tr>
<tr>
<td>2</td>
<td>0.89464; 131.97818</td>
<td>131.97818</td>
</tr>
<tr>
<td>3</td>
<td>0.85558; 131.99097</td>
<td>131.99097</td>
</tr>
<tr>
<td>4</td>
<td>0.82063; 131.79863</td>
<td>131.79863</td>
</tr>
<tr>
<td>5</td>
<td>0.92156; 131.63995</td>
<td>131.63995</td>
</tr>
<tr>
<td>6</td>
<td>0.84891; 132.01016</td>
<td>132.01016</td>
</tr>
<tr>
<td>7</td>
<td>0.87785; 132.17943</td>
<td>132.17943</td>
</tr>
<tr>
<td>8</td>
<td>0.83744; 132.18095</td>
<td>132.18095</td>
</tr>
<tr>
<td>9</td>
<td>0.84166; 132.71635</td>
<td>132.71635</td>
</tr>
<tr>
<td>10</td>
<td>0.83000; 132.34953</td>
<td>132.34953</td>
</tr>
</tbody>
</table>
```
The first value (5) indicates after what line of the file the actual data start.
The second value (3) tells the user the number of data sets (columns) which are contained within the file.
The third value (640) lists the number of rows of data (only 10 of 640 are shown here).
The fourth line contains the general data description and the fifth describes each data set (column).

To export data to a file, proceed as follows:

- Open the export dialog (→ Export → Data)
- Select a data format and, if necessary, a delimiter (CSV).
- Hit one of the data set buttons (Figure 50c). Subsequently, AviStack2 asks you to select a file name.
- Hit another data set button if you want to export another data set.
- Hit OK when you are finished.
8 Creating flat-fields and dark frames

If you want to use a flat-field and/or a dark frame during processing or just for the frame stacking, you will have to have recorded such data.

Then, load the respective file(s) and right click on them. A context menu pops up where you can select what to generate (Figure 51).

Immediately after that, AviStack2 will open the selected file and averages all the frames. You will then get asked to select a file to save the flat-field or dark frame.

The data are saved as FITS in the selected directory.

A flat-field does not just contain the average data, but, the average data divided by their median value. In case of RGB data, each of the channels is divided by the median pixel value of that channel. Therefore, it contains values around 1.0.

You can subsequently load the flat-field and/or dark frame for processing using the stacking dialog (Section 4.13). If you want to use the data not only for stacking, but, for all processing steps, set the respective flag in the frame alignment dialog (Section 4.3).

Flat-fields and dark frames that you want to use within AviStack2 will have to have been created with AviStack2.
9  **AviStack2 data files (.asd)**

AviStack2 allows to save a current session as an AviStack data file (.asd) (*File → Save data*). It will contain all the parameter settings (including post-processing) and data of the currently processed movie. However, it does not save the files listed in the processing list (Section 3.1.3).

It is also possible to load with AviStack2 .asd files created with AviStack1.x.

Data files are a great way to pre-process a movie and save the incomplete data for batch processing (Section 5.2). You can load the data files into the processing list via *File → Load data* or by using the respective button above the processing list (Figure 2d). That way AviStack2 will implement all the stored parameters before continuing processing where you left it. Therefore, this is one of the ways to process movies with different parameter settings during batch processing.

You can ask AviStack2 to automatically save when frame stacking is complete an AviStack2 data file by activating the respective button above the processing list (Figure 2h).

When you close AviStack2, it will also write to the AviStack2 program directory an .asd file containing the parameters of the current session. You can restore this file with *File → Restore session*. 
10 AviStack2 parameter files (.asp/.wrkf)

There are two different file types that store processing parameters. The .asp files contain all the processing parameters except for post-processing. The latter’s parameters are stored in workflow files (.wrkf).

Most of the processing dialog windows allow to save parameter files via → Parameters → Save and also to load them (→ Parameters → Load). When you do this via one of the processing dialog menus, only the parameters for that module will be saved. If you load a parameter file via that menu, only the parameters used by that module are implemented, e.g., the frame stacking module will only store or implement the flat-field and dark frame settings.

If you want to create a parameter file that contains all the processing parameters, do this via the menu of the file menu of the main GUI (Section 3.1). Select → File → Save parameters or → Load parameters.

If you want to save or load workflow files, you can do this via the Parameters menu of the post-processing dialog window.

Parameter and workflow files are very useful if you want to save some basic processing parameters e.g. for a certain type of movies. They can also be used for batch processing by attaching them to movies in the processing list. The parameters will then get implemented before the respective file is processed. This allows you to process different file with different parameters (also post-processing by attaching .wrkf files) during batch processing (Section 5.2).

You can make AviStack2 automatically save a .asp file when you save the stacked image and a .wrkf file when you store the post-processed image. That way you will always know how you processed a certain movie.
11 Language support in AviStack2

In the old AviStack1.x, it was impossible to implement a new language without help of the developers.

Now, everyone can create a new language library and try it out immediately.

This is possible as AviStack2 uses XML files to import the language data for the buttons and dialogs.

Before you start compiling a new library, please contact the developers anyway to prevent double work. Someone else may already have started translating AviStack2 to the language of your choice. Also, it would be good to agree with the developers on the three letter language code. When you have finished creation of a new library, please notify me (Michael Theusner):

michael@avistack.de.

Then, the new library can be distributed via the AviStack homepage to the benefit of all AviStack2 users.

Writing such a library also brings with it some responsibility on your part as it would be nice if you were willing to update the library for new versions of AviStack2.

11.1 Structure of the XML language files

The XML language files have a simple structure that you must not change. As an example, the XML file for the export data dialog is listed below.

The XML files are all contained in the language directory of your AviStack2 program directory.

```xml
<?xml version="1.0" encoding="ISO-8859-1"?>
<!--
Language data of the data export GUI.
-->  
<catalog id = "AS2_ExportData__define">
  <language id="ENG">
    <var id="title">Export data</var>
    <var id="help">Help</var>
    <array id="help_txt">
      <element>Allows to export data to a user selected file.</element>
    </array>
  </language>
</catalog>
```
11.2  How to create a new library

Before you modify the XML files, make a copy of them all. If something goes wrong, you can always download them again from the AviStack2 homepage (http://www.avistack.de). You will know something went wrong when an error message appears during start up of AviStack2.

Please, always use the English XML files as the starting point for translation!

How to rename the files: Best method is to open in a text editor or XML editor a file you want to translate. Then use the Save as functionality to save it under a new name. However, the only thing you’re allowed to change about the file name is the three letter language code, i.e. the ENG. Select a new one that you have agreed upon with the developers. For French this would e.g. be FRE. Make them upper case letters.

How to know which XML file belongs to which dialog: This may look difficult at first and it may not be trivial on some rare occasions. However, at its top each XML file contains a short description of the module it belongs to (between <!-- and -->). Additionally, simply start AviStack2 and use the ubiquitous Help buttons (see Section 12) to open the help menu for a certain processing module. At the bottom of the help text, the file name is listed (Figure 52).
Figure 52: The XML source for the language data of a certain processing module is given at the bottom of the help text. in this case it is AS2_Batch_ENG.xml.

This should make it reasonably easy to find the correct file.

**What to translate:** Translate the text which is enclosed by `<element>text</element>` or `<var . . . >text</var>`.

**What you must not change:**

- Do not change the XML comment section (`<!– –>`)  
- Do not alter the XML file name at the end of the help text (`<array id="help_txt">`). Leave the ENG suffix in place.  
- Do not translate the file *GenFitsHead_ENG.xml*.

**How to test the new library:** You do not have to translate all the files to use the new library. As soon as there is one file with a new language suffix, it will be detected by AviStack2 at start up. Then you can go to → *Settings* → *Language* and select the new language.

AviStack2 will then ask you to restart the program to implement the new language.
12 Help functionality in AviStack2

AviStack2 contains an extensive help functionality. For almost all processing dialogs, help buttons are available (Figure 53). Click on one of them and a window pops up (Figure 52) with a detailed explanation of that processing step and what AviStack2 expects you to do and what your options are. If you do not know what to do, click that button.

The help window has a fixed size and you may have to scroll down to read all the text. AviStack2 remembers the location of the help window and restores it in the same location if you hit another help button.

At the bottom of each help text, the source file of that text is given. The same source file also provides the button text and other text that is used for the GUI where the help button is located. This is important information for those who want to create new language libraries and do not initially know which library file belongs to which part of AviStack2.

In addition to the help buttons, there also is a small text window just below the file menu (Figure 54). It will display information on what AviStack2 expects you to do or what it is currently doing as you progress through processing.
If you need more extensive help, read this manual or join the AviStack User Group:

http://tech.groups.yahoo.com/group/AviStack/

You can also contact me if you have questions and recommendations:

michael@avistack.de
A new feature in AviStack2 is the statistics package. It allows you to analyze certain statistical properties of regions of interest (ROI) throughout a movie. The data can be saved via the data export function (see Section 7). You can load the exported data with external programs for further analysis. This is useful e.g. to analyze brightness changes of objects or regions in your image such as variable stars and minor planet transits and exoplanet transits (see http://www.theusner.eu/astro/exo.html).

The statistics package becomes available as soon as processing has progressed past the frame alignment diagram (Section 4.4). This is because it relies on properly aligned frames.

You can open the dialog window via → Extras → Start statistics package.

Once you have opened the dialog (Figure 55), you can start adding statistics objects for each ROI (which can consist of several independent regions). Each ROI is defined by one or several polygons which can be drawn with the mouse cursor (Section 57). For each of the ROIs you can select various analysis methods.
In some cases it may be better to use the average frame for defining the ROIs as it exhibits far less noise than a single frame. The average frame is created during frame alignment from all active frames. Check the box *Show average frame* to display it. The frame selector is then disabled (Figure 55). There are additional modifications of the display like edge enhanced and inverted.

After completing your settings, hit *Analyze* to start the statistical analysis. AviStack2 will then loop through all the frames of the movie and analyze each ROI using the selected analysis methods. When this is complete, you can export the data using the button *Export*.

You can save all the parameters of your analysis (the ROI locations etc.) via → *Parameters* → *Save* (.asst file). This allows to load the ROIs again (→ *Parameters* → *Load*) for another analysis or for modification.

### 13.1 The statistics objects

To be able to define a ROI for analysis, you will have to create a statistics object first. This is done by hitting the appropriate button (Figure 55). A statistics object entry is added to the tree diagram together with a methods folder and an entry for the first polygon (Figure 56a). Additionally, a dialog window for that statistics object is opened. You can then decide which analysis methods to use by checking the appropriate boxes in that dialog. In this example Mean and Standard deviation are selected. These methods are then listed in the methods folder of the tree diagram for that statistics object (Figure 56b).

You can also delete a statistics object by selecting it in the tree diagram and using the appropriate button. You can only undo the last of your actions in this module.

### 13.2 Defining polygons for an ROI

As soon as you have created a statistics object, you can start defining its ROI. This ROI may consist of one or several polygons. The first such polygon was already created with the statistics object. You can then use the mouse to define its boundary vertices. Just click on a location of your choice with the left mouse button to create a vertex. You can extend the polygon while it is open (dashed boundary) by adding more vertices (Figure 57a). To close it, drag the last vertex on the location of the first. The
13.2 DEFINING POLYGONS FOR AN ROI

(a) A pristine statistics object.

(b) Selecting analysis methods.

Figure 56: Working with a statistics object.
An open polygon.

A closed polygon.

Adding and dragging a vertex.

Figure 57: Creating and extending a polygon.

line then changes its appearance to solid (Figure 57b). After closing a polygon, you can still add new vertices by clicking on a boundary line, holding the left mouse button and dragging the mouse. Delete vertices by double clicking them.

You can move the whole polygon by holding the right mouse button and dragging the mouse (Figure 58a). If you do this close to one of the vertices, you are able to rotate the polygon (Figure 58b).

You can add more polygons to that ROI by using the Add polygon button from the statistics object’s dialog window. Then you will be able to define another polygon for that ROI (see Figure 59 for an example with multiple ROIs with multiple polygons each).

All the pixels of the polygons of one ROI are treated as one entity. This means that AviStack2 will compute e.g. one mean value from the pixels of a ROI even if it consists of several polygons.

You can delete a whole polygon by selecting the delete polygon button from the statistics object’s dialog.

To modify a certain polygon, double click on its tree entry. The activity state of each polygon can be seen from its boundary. Active closed polygons have a solid boundary line and active open ones a dashed line. Inactive polygons have a dotted boundary line.

You can also modify the color for the polygons of a ROI by clicking on the color button in the statistics object’s dialog window (Figure 59).
13.2 DEFINING POLYGONS FOR AN ROI

Figure 58: Creating and extending a polygon.
**Figure 59:** An example with three statistics objects. Two of the statistics objects’ ROIs consist of multiple polygons. The ROIs can be distinguished by their different colors. In this example the brightness of the star HD 189733 is compared to that of several reference stars to detect an exoplanet transit. As additional information the change of background brightness was also analyzed.
14 Creating your own AviStack2 plug-ins

It is now possible to write your own IDL object plug-ins to process data provided computed by AviStack2. Just create an IDL object, compile it and save the compiled routines to an IDL save file. You will have to use a certain interface structure to make your module compatible with AviStack2. One example program is included in the package you download from the AviStack2 homepage. Its name is AS2PI_tpl.pro. If you want to create a new object, substitute tpl everywhere in the file, i.e. for all methods and named structures. Then save the object under its new name.

All the modules you write must start with AS2PI. AviStack2 will search for such objects on start-up and add an entry in the menu Extras. You can then start your module from that menu. However, you will have to provide information on when it is OK to start you module via a progress flag (see AS2PI_tpl::Init). So if you want to process the final image, you will certainly have to wait until it is available. The value of this flag depending on progress is listed in Table 1. Select an appropriate value from the table and set self.prog to that value in your object's Init method.

All the parameters that you select during processing and all the data that are computed can be accessed via AviStack2's GetProperty method. The object reference of AviStack2 is stored in the user value of AviStack2's top level base (TLB). It can be obtained via the self.group_leader parameter which contains the ID of the TLB:

```
;Load AviStack2's object reference
Widget_Control, self.Group_Leader, Get_uValue = AviStack2

;Obtain final image
image = AviStack2->GetProperty(/FrameS)
```

The parameters and datasets that can be accessed are listed below.

<table>
<thead>
<tr>
<th>Description</th>
<th>Keyword</th>
<th>Data format</th>
<th>Size</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>General parameters</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Program version</td>
<td>ver_nr</td>
<td>String</td>
<td>Scalar</td>
<td></td>
</tr>
<tr>
<td>Program release data</td>
<td>ver_date</td>
<td>String</td>
<td>Scalar</td>
<td></td>
</tr>
<tr>
<td>Progress flag value</td>
<td>prog</td>
<td>Long</td>
<td>Scalar</td>
<td>Depends on progress.</td>
</tr>
<tr>
<td>Movie data and parameters</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Currently processed</td>
<td>file</td>
<td>String</td>
<td>Scalar</td>
<td></td>
</tr>
<tr>
<td>movie file name</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Feature</td>
<td>Type</td>
<td>Description</td>
<td></td>
<td></td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>---------</td>
<td>-----------------------------------------------------------------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Current work path</td>
<td>String</td>
<td><code>workPath</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Gray scale / RGB flag</td>
<td>Long</td>
<td><code>channels</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Maximum pixel value</td>
<td>Double</td>
<td><code>maxval</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td>List of file names for image series</td>
<td>String</td>
<td><code>NamesList</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Number of frames of the movie</td>
<td>Long</td>
<td><code>nFrames</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Frame x-dimension</td>
<td>Long</td>
<td><code>dx_</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Frame y-dimension</td>
<td>Long</td>
<td><code>dy_</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Frame selection data and parameters</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Number of active frames</td>
<td>Long</td>
<td><code>naFrames</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td>List of active frames</td>
<td>Long</td>
<td><code>aFrames</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Frame quality (frame selection)</td>
<td>Float</td>
<td><code>fs_quality</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Average frame brightness (frame selection)</td>
<td>Float</td>
<td><code>fs_bright</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Channel selection flag</td>
<td>Integer</td>
<td><code>aChan</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Quality analysis flag</td>
<td>Integer</td>
<td><code>fs_qa</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Quality cut-off</td>
<td>Float</td>
<td><code>fs_qco</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Frame cut-off</td>
<td>Long</td>
<td><code>fs_fco</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Use frame cut-off flag</td>
<td>Integer</td>
<td><code>fs_ffco</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Brightness cut-off</td>
<td>Float</td>
<td><code>fs_bco</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Frame alignment data and parameters</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reference frame number</td>
<td>Long</td>
<td><code>rFrame</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alignment point x-location</td>
<td>Long</td>
<td><code>apx</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alignment point y-location</td>
<td>Long</td>
<td><code>apy</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Frame shift in x</td>
<td>Long</td>
<td><code>vx</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Frame shift in y</td>
<td>Long</td>
<td><code>vy</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Relative deviation between alignment points</td>
<td>Float</td>
<td><code>vh</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Average frame (reference for reference point alignment etc.)</td>
<td>Float</td>
<td><code>mFrame</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x-dimension of minimum area</td>
<td>Long</td>
<td><code>dxn</code></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Properties:**
- `workPath` (String): Current work path.
- `channels` (Long): Gray scale / RGB flag.
- `maxval` (Double): Maximum pixel value.
- `NamesList` (String): List of file names for image series.
- `nFrames` (Long): Number of frames of the movie.
- `dx_` (Long): Frame x-dimension.
- `dy_` (Long): Frame y-dimension.
- `naFrames` (Long): Number of active frames.
- `aFrames` (Long): List of active frames.
- `fs_quality` (Float): Frame quality (frame selection).
- `fs_bright` (Float): Average frame brightness (frame selection).
- `aChan` (Integer): Channel selection flag.
- `fs_qa` (Integer): Quality analysis flag.
- `fs_qco` (Float): Quality cut-off.
- `fs_fco` (Long): Frame cut-off.
- `fs_ffco` (Integer): Use frame cut-off flag.
- `fs_bco` (Float): Brightness cut-off.
- `rFrame` (Long): Reference frame number.
- `apx` (Long): Alignment point x-location.
- `apy` (Long): Alignment point y-location.
- `vx` (Long): Frame shift in x.
- `vy` (Long): Frame shift in y.
- `vh` (Float): Relative deviation between alignment points.
- `mFrame` (Float): Average frame (reference for reference point alignment etc.).
- `dxn` (Long): x-dimension of minimum area.
| Parameter Description                                           | Type  | Scalar
|-----------------------------------------------------------------|-------|-------
| y-dimension of minimum area                                      | dyn   | Long  
| x-offset of minimum area                                         | sxn   | Long  
| y-offset of minimum area                                         | syn   | Long  
| x-dimension of maximum area                                      | dxx   | Long  
| y-dimension of maximum area                                      | dyx   | Long  
| x-offset of maximum area                                         | sxx   | Long  
| y-offset of maximum area                                         | syx   | Long  
| Area radius                                                      | ar    | Long  
| Search radius                                                    | sr    | Long  
| Alignment type                                                   | aType | Long  
| Use flat/dark for alignments flag                                | useFD | Integer
| ROI data                                                        |       |       
| x-dimension of ROI                                               | dxr   | Long  
| y-dimension of ROI                                               | dyr   | Long  
| x-offset of ROI                                                  | xr0   | Long  
| y-offset of ROI                                                  | yr0   | Long  
| Reference point data and parameters                              |       |       
| x-locations of reference points                                  | px    | Long  
| y-locations of reference points                                  | py    | Long  
| Threshold value                                                  | thr   | Long  
| Lower cut-off value                                              | lco   | Float 
| Upper cut-off value                                              | uco   | Float 
| Minimum distance between reference points                        | mindist| Long  

Reference point alignment data and parameters
### Reference point x-shifts

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Dimensions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>px</td>
<td>Long</td>
<td>Array[nRP, naFrames]</td>
<td></td>
</tr>
<tr>
<td>nRP = number of reference points.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Reference point y-shifts

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Dimensions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>py</td>
<td>Long</td>
<td>Array[nRP, naFrames]</td>
<td></td>
</tr>
<tr>
<td>nRP = number of reference points.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Alignment radius

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Dimensions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>rar</td>
<td>Long</td>
<td>Scalar</td>
<td></td>
</tr>
</tbody>
</table>

### Search radius

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Dimensions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>rsr</td>
<td>Long</td>
<td>Scalar</td>
<td></td>
</tr>
</tbody>
</table>

### Automatic search radius flag

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Dimensions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>arsr</td>
<td>Long</td>
<td>Scalar</td>
<td></td>
</tr>
</tbody>
</table>

### Quality cut-off

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Dimensions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>qco</td>
<td>Float</td>
<td>Scalar</td>
<td>Range = 0...100.</td>
</tr>
</tbody>
</table>

### Frame cut-off

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Dimensions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>fco</td>
<td>Long</td>
<td>Scalar</td>
<td></td>
</tr>
</tbody>
</table>

### Use frame cut-off flag

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Dimensions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>fco</td>
<td>Long</td>
<td>Scalar</td>
<td></td>
</tr>
</tbody>
</table>

### Quality analysis data and parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Dimensions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>qpx</td>
<td>Long</td>
<td>Array[nQA]</td>
<td></td>
</tr>
<tr>
<td>nQA = number of quality areas.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Quality area y-centers

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Dimensions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>qpy</td>
<td>Long</td>
<td>Array[nQA]</td>
<td></td>
</tr>
<tr>
<td>nQA = number of quality areas.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Quality data for quality areas

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Dimensions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>quality</td>
<td>Float</td>
<td>Array[nQA, naFrames]</td>
<td></td>
</tr>
<tr>
<td>nQA = number of quality areas.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Noise reduction parameter

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Dimensions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>nr</td>
<td>Long</td>
<td>Scalar</td>
<td></td>
</tr>
</tbody>
</table>

### Quality area size

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Dimensions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>qas</td>
<td>Long</td>
<td>Scalar</td>
<td></td>
</tr>
</tbody>
</table>

### Quality analysis method

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Dimensions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>qam</td>
<td>Long</td>
<td>Scalar</td>
<td></td>
</tr>
</tbody>
</table>

### Frame stacking data and parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Dimensions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FrameS</td>
<td>Double</td>
<td>Array[[3, dxx, dxy]]</td>
<td>Dimensions depend on channels.</td>
</tr>
</tbody>
</table>

### Stacked image data (final image)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Dimensions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>flat</td>
<td>String</td>
<td>Scalar</td>
<td></td>
</tr>
</tbody>
</table>

### Dark frame file name

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Dimensions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>dark</td>
<td>String</td>
<td>Scalar</td>
<td></td>
</tr>
</tbody>
</table>

### Save stacked image data and parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Dimensions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>si_fout</td>
<td>String</td>
<td>Scalar</td>
<td></td>
</tr>
</tbody>
</table>

### Rotation flag

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Dimensions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>si_rot</td>
<td>Integer</td>
<td>Scalar</td>
<td>0, ..., 3 = 0°, ..., 270°.</td>
</tr>
</tbody>
</table>

### Flip image flag

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Dimensions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>si_flip</td>
<td>Integer</td>
<td>Scalar</td>
<td>0=horizontal; 1=vertical.</td>
</tr>
</tbody>
</table>

### Saved area flag

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Dimensions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>si_area</td>
<td>Integer</td>
<td>Scalar</td>
<td>0=max area; 1=min area; 2=ROI.</td>
</tr>
</tbody>
</table>

### Image type

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Dimensions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>si_type</td>
<td>String</td>
<td>Scalar</td>
<td></td>
</tr>
</tbody>
</table>

### Bit depth

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Dimensions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>si_bit</td>
<td>Long</td>
<td>Scalar</td>
<td></td>
</tr>
</tbody>
</table>

### Output file suffix

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Dimensions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>si_sfx</td>
<td>String</td>
<td>Scalar</td>
<td></td>
</tr>
</tbody>
</table>

### Output directory

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Dimensions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>si_dout</td>
<td>String</td>
<td>Scalar</td>
<td></td>
</tr>
</tbody>
</table>

### Use output directory as default flag

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Dimensions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>si_sdir</td>
<td>Integer</td>
<td>Scalar</td>
<td></td>
</tr>
<tr>
<td>Save parameter file flag</td>
<td>si_sPar</td>
<td>Integer</td>
<td>Scalar</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------</td>
<td>---------</td>
<td>--------</td>
</tr>
</tbody>
</table>

**Save processed image data and parameters**

<table>
<thead>
<tr>
<th>File name of post-processed image</th>
<th>pi_fout</th>
<th>String</th>
<th>Scalar</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rotation flag</td>
<td>pi_rot</td>
<td>Integer</td>
<td>Scalar</td>
</tr>
<tr>
<td>Flip image flag</td>
<td>pi_flip</td>
<td>Integer</td>
<td>Scalar</td>
</tr>
<tr>
<td>Saved area flag</td>
<td>pi_area</td>
<td>Integer</td>
<td>Scalar</td>
</tr>
<tr>
<td>Image type</td>
<td>pi_type</td>
<td>String</td>
<td>Scalar</td>
</tr>
<tr>
<td>Bit depth</td>
<td>pi_bit</td>
<td>Long</td>
<td>Scalar</td>
</tr>
<tr>
<td>Output file suffix</td>
<td>pi_sfx</td>
<td>String</td>
<td>Scalar</td>
</tr>
<tr>
<td>Output directory</td>
<td>pi_dout</td>
<td>String</td>
<td>Scalar</td>
</tr>
<tr>
<td>Use output directory as default flag</td>
<td>pi_sdir</td>
<td>Integer</td>
<td>Scalar</td>
</tr>
<tr>
<td>Save workflow file flag</td>
<td>pi_sPar</td>
<td>Integer</td>
<td>Scalar</td>
</tr>
</tbody>
</table>

If you want to write plug-ins for AviStack2 (IDL objects) or have questions about how to do this, please, contact me:

michael@avistack.de
<table>
<thead>
<tr>
<th>After processing step</th>
<th>progress flag value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process file</td>
<td>100</td>
</tr>
<tr>
<td>Frame selection</td>
<td>200</td>
</tr>
<tr>
<td>Frame alignment parameter selection</td>
<td>300</td>
</tr>
<tr>
<td>Frame alignment</td>
<td>400</td>
</tr>
<tr>
<td>Frame alignment diagram</td>
<td>500</td>
</tr>
<tr>
<td>Frame aligned movie</td>
<td>500</td>
</tr>
<tr>
<td>ROI selection</td>
<td>700</td>
</tr>
<tr>
<td>Set reference points</td>
<td>799</td>
</tr>
<tr>
<td>Quality analysis parameters</td>
<td>800</td>
</tr>
<tr>
<td>Quality analysis</td>
<td>999</td>
</tr>
<tr>
<td>Quality analysis diagram</td>
<td>1000</td>
</tr>
<tr>
<td>Quality aligned movie</td>
<td>1000</td>
</tr>
<tr>
<td>Reference point alignment parameters</td>
<td>1100</td>
</tr>
<tr>
<td>Reference point alignment</td>
<td>1300</td>
</tr>
<tr>
<td>Reference point alignment diagram</td>
<td>1300</td>
</tr>
<tr>
<td>Frame stacking parameters</td>
<td>1400</td>
</tr>
<tr>
<td>Frame stacking (final image available)</td>
<td>1500</td>
</tr>
<tr>
<td>Save stacked image</td>
<td>1600</td>
</tr>
<tr>
<td>Post-processing</td>
<td>1600</td>
</tr>
<tr>
<td>Save processed image</td>
<td>1700</td>
</tr>
</tbody>
</table>

*Table 1: Progress flag values (self.prog)*